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Radio Frequency Circuits Laboratory

Excercise 5
Simulation of Long Lines with Travis Software



Aim of the exercise

The aim of this exercise is to examine the electromagnetic wave propagation in the
transmission lines using TRAVIS software. You should also become acquainted with the
basic rules for designing different types of the transmission lines and analyzing their
transmission properties for different kinds of impedance loads.

Transmission lines – background information

Transmission line consists of two parallel conductors held apart at a fixed distance by
insulators or by insulation. It is used to transfer electrical energy, e.g. output rf energy. The
types of transmission lines used for transmitting rf signals are presented in figure 3. The
dielectric material is marked in green. It is a mechanical component of the transmission line
and has influence on the line’s electrical properties.
Transmission line can be approximated by a distributed-parameter network provided the
length of the transmission line is comparable with the wavelength of the transmitted signal
through this line. The conductors of such transmission line can be characterized by:
distributed resistance (Ω/m), distributed inductance (H/m) and distributed capacitance (F/m).
In low frequencies (hundred of hertz) the reactance of the transmission line can be omitted.
However, as the frequency increases, the reactance values must be taken into consideration.
Moreover, the time needed for the transmitted wave to reach the end of the line increases and
becomes the large part of the input signal period (the propagation time can be longer than the
signal’s period).
The transmission line with distributed parameters is called the long line. This name is related
to the wave character of the electromagnetic phenomena which must be included when
describing the propagation of the signal in the transmission line. For the frequency of few
GHz the wavelength is equal to several centimeters, therefore the length of the transmission
line is given in units of the transmitted signal wavelength.
One of the most important parameters characterizing the electrical properties of a
transmission lines characteristic impedance. Assuming the distributed resistance of the line is
much smaller than the reactance of the line, the characteristic impedance is given by the
formula:

[ ]Ω=         0 C
LZ

where:
L – unit inductance of the transmission line;
C – unit capacitance of the transmission line;

Inductance L and capacitance C can be measured directly. The ratio of L to C is comparable
to the load resistance of the line necessary to avoid the reflections of the wave transmitted
through the line. If this condition is not fulfilled, the mismatching impedance can cause the
generation of unwanted currents and voltages traveling along the transmission line in both
directions. These currents and voltages can cause power losses and distortions of the
transmitted signal.



In practice three kinds of losses may occur in transmission lines for rf signals (even if we have
the impedance matching):

- losses in the conductor resulting in heat generation from current flow;
- losses in the dielectric resulting in heating the isolator;
- radiation and induction losses resulting from transmitting power from the line to the

neighboring cables, or power radiated to the environment.
As a result the transmitted signal is suppressed. The suppression determines the power loss in
the transmission line and is measured in dB per unit length.

TRAVIS – quick start

TRAVIS is an electronic circuit simulation program designed to allow visualization of
propagating waveforms as they travel along the transmission lines. It works in Windows
environment and allows full flexibility and ease in creating analyses that contain the
transmission lines of interest.

1.  Start TRAVIS.
2. Pull down the “File” menu and select “Open Project”. The Open File dialog box

appears. Select the file “example1.pro” and click the “OK” button. The scheme of the
electrical circuit will appear in the Main Circuit Window. The circuit consists of
transient voltage source V1 of the pulse shape, transmission line T1 with characteristic
impedance Z0=50Ω connected in series with resistor R1=25Ω. The load impedance for
this circuit is the resistor R2=1kΩ. The voltage on the resistor R2 is the input signal
for the circuit.

Figure 1 Electrical circuit containing the transmission line.

Description of the transient pulse voltage source: “tran=pulse(iv,pv,td,tr,tf,pd,T)”
where:
iv – initial value;
pv – pulsed value;
td – delay time;
tr – rise time;
tf – fall time;
pd – pulse duration;
T – period;
Graphical transient pulse definition is presented in figure 2.



Figure 2 Transient Pulse Definition.

Transmission line parameters: “td” – propagation length, which specifies the length of
the transmission line in seconds (must be greater than zero); “Z0” – characteristic
impedance of the transmission line in ohms (must be greater than zero).

3. Pull down the “analysis” menu and select “Run Transient Analysis”. The analysis
Status dialog box pops up showing the progress of the analysis. When the analysis is
complete, click “OK” button.

4. Position the mouse pointer over the wire connecting to the right-hand side of the
transmission line in the circuit (it has the node marker “out” attached to it). Push down
left mouse button. A small menu pops up; select “v(out)” and release the mouse
button. A transient plot pops up with the voltage waveform from that wire. Notice how
distorted the waveform looks due to reflections on the transmission line (R2≠Z0).

5. Pull down the “See Results” menu and select “stick All Plots on Top”. This will cause
the plot to stick on the top of the schematic. Pull down the “See Results” menu again
and select “Use Active Plot” and “Stick All Plots on Top”. This will cause any more
waveforms that you plot to be sent to the waveform plot that is already open.

6. Move and resize the plot window so that it does not obscure the circuit in the circuit
window. Pull down “See Results” menu and select “Animate Transient Animation
Plots”. The Animation Control dialog box pops up. Press “Play” button in the
Animation Control dialog box. The voltage waveform within the transmission line
starts animating. Also notice that an “X” marker is moving along the waveform in the
plot window corresponding to voltage versus time on that node. When you are
finished looking at the animation results, close the Animation Control dialog box by
clicking the “Done” button.

7. Position the mouse pointer over the circuit window and click the right mouse button
until the status text in the upper left corner of the circuit window says “Edit Circuit”
(this mode allows for changing the values characterizing any component of the
circuit).

8. Position the mouse pointer over the resistor “R2” in the circuit and click the left mouse
button. The Edit Component dialog box pops up for the resistor.

9. In the parameter field, the resistor parameters are listed, among them “r=1k”. Change
this to “r=50” and click the “OK” button of the dialog box. This will properly
terminate the transmission line.

10. Repeat steps 3 and 4. Now there are two waveforms in the plot.



11. Pull down the “See results” menu and select “Animate Transient Animation Plots”.
The Animation Control dialog box pops up. Press the play” button again. Now notice
that the waveform has no reflections (R2=Z0).

Examined circuit can be extended using commands form the “Place” menu. You will find
there the list of primitive components that can be placed in the circuit: wire, resistor,
capacitor, inductor, voltage source, current source, transmission line, etc.
You can delete any of the components by selecting “Cut Whatever is Touched” from the
“Edit” menu. In order to undo an action, select the “Undo” item from the same “Edit”
menu.
To save current project to disc, select the “Save project” (without changing the project’s
name) of the “Save Project as” item (when you want to change the project’s name) from
the “File” menu.

Designing the transmission line

TRAVIS contains a Transmission Line Designer tool that allows you to see a graphical
representation of a transmission line’s cross section. The Transmission Line Designer also
features the ability to calculate any transmission line parameter given the others. Four
different types of transmission lines are supported: microstrip, stripline, coaxial and twin
lead. They are presented in figure 3. Table 1 contains characteristic impedance equations
for different types of transmission lines.

Figure 3 Cross sections of diffenert types of transmission lines: a) coaxial cable, b) twin lead line, c)
microstrip line, d) stripline.



Table 1

Type of the transmission line Characteristic impedance
equation Z0[Ω]
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Let us examine the parameters of the transmission line form project “example1.pro”.
1. Load “example1.pro”
2. Select ”Transmission Line Info” item from the “Edit” menu. The status text will

display “Click t-line for T-line Designer”. While in this mode, click left mouse button
over the transmission line whose cross section you want to examine.

The “Transmissionline Designer” window, containing the cross section of the transmission
line and its dimensions, is displayed. In our case the transmission line is of the coaxial type.
The dimensions are given in units defined in the “Length Units” filed (mils=0.001inch, 1
inch≈25.4mm). At the top of the window is the characteristic impedance (Z0) and a message
display. Note that the Z0 displayed hare correctly corresponds to the cross section drawing
only after performing a calculation by selecting one of the items from the “Calculate” menu
(except for the “Plot” item).
Transmission line dimensions can be edited by clicking on the picture of the transmission line.
A dialog box will pop up with the parameters that can be edited (figure 4).

Figure 4 Coaxial Parameter dialog box

For defined dimensions of the transmission line, the characteristic impedance will be
calculated when “Z0” item is selected from the “Calculate” menu. Similarly, changing the Z0
value (e.g. 75Ω), you can calculate the corresponding values of remaining three parameters,
e.g. relative dielectric constant of the insulator by selecting “er” item from the “Calculate”
menu.



To make a plot of one transmission line parameter versus another (with the other parameters
held constant), select the “Plot” menu item from the “Calculate” menu. A dialog box pops up
with three regions. The top two regions are Horizontal Axis and Vertical Axis. In the bottom
region (Horizontal Axis Limits) you choose the range of the horizontal axis variable and the
number of points to calculate within the range. Clicking the “Run Plot” button causes a plot
window to pop up with the information requested.

Measurement procedure

I. Designing different types of transmission lines

1. You are given the stripline (fig. 3d) with the following parameters: height of
the insulator h=13.8mils, relative dielectric constant of the insulator
er=4.0F/m, thickness of the conductor t=3.0 mils. Using TRAVIS software
find the width of the conductor (w=?) such that the characteristic impedance of
the transmission line is equal to Z0=50Ω. Plot the dependence of the
characteristic impedance versus the width of the conductor using appropriate
TRAVIS tools.

2. You are given the coaxial transmission line (fig. 3a) with the following
parameters: characteristic impedance Z0=50Ω, and the diameter of the outer
conductor 2R=13.8 mils. What is the dielectric constant of the of the insulator
used in this transmission line? What should be the value of the dielectric
constant for the same dimensions of this transmission line to get the
characteristic impedance equal to Z0=75Ω? Plot the dependence of the
characteristic impedance versus the geometric parameters of the transmission
line using appropriate TRAVIS tools.

3. Compare the characteristic impedance values for all four types of the
transmission line from fig. 3 calculated from the equations given in Table I,
and values of Z0 obtained using TRAVIS software, provided that the air is the
insulator.

II. Examining the transmission line for different impedance loads.

Using TRAVIS software, design the electrical circuits presented in figures 5, 6 and 7. The
transmission line is of the coaxial type, the characteristic impedance Z0=50Ω, and the
delay time td=250ns. The load is:

a) mismatching resistance (fig. 5)
b) capacitive load (fig. 6)
c) inductive load (fig. 7)

Design the electrical circuits with transmission line:
d) ended with open-circuit
e) ended with short-circuit
f) matching resistance load

For all cases perform the simulation of the propagating waveforms as they travel along the
transmission line using TRAVIS software. Observe the input and output voltage
waveform. In the report include the printouts of the obtained plots and explain their shape.



Figure 5 Transmission line with mismatching resistive load.

Figure 6 Transmission line with capacitive load.

Figure 7 Transmission line with inductive load.


